Version:  Fall 2003


Name                                   _               
Your Lab Time (8, 9:30, 1, 2:30)             



SCIENCE 101    LABORATORY #3



Introduction to Motion

Prelab Questions


Carefully read the laboratory handout before coming to lab, and answer the following questions.  Please circle your lab time in the upper right hand corner of this sheet, and put this sheet in the box on the instructor’s table at the front of the lab room when you enter.

Q1)  What is the minimum distance for which the motion detector will give accurate readings?                   

Q2)  You will study two types of graphs in this lab.  What quantity is plotted on the horizontal axis in these graphs?                                      

Q3)  What two quantities are plotted on the vertical axes in the two graphs you will be studying? (Position and distance are considered the same quantity)

__________________ and __________________

Q4)  In the activities you will be asked to match two different graphs.  What does it mean to ‘match a graph’ in this lab?                                                  

Q5  Below is an arrow representing an object moving with a velocity of +3 m/s.  Using this as your reference draw a vector representing a velocity of –9 m/s.                                                                           



SCI 101   LAB #3:  INTRODUCTION TO MOTION
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Slow and steady wins the race.
Aesop's fable:  The Hare and the Tortoise

Objectives

•
To discover how to measure motion with a motion detector

•
To see how motion looks as a distance (position)-time 
graph

•
To see how motion looks as a velocity-time graph

•
To discover the relationship between position-time and velocity-time graphs

•
To get practice reading graphs.

Overview

In this lab you will examine two different ways that the motion of an object can be represented graphically.  You will use a motion detector to plot distance (position) and velocity-time graphs of the motion of your own body.  The study of motion and its mathematical and graphical representation is known as kinematics.    
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The motion detector works by emitting a brief pulse of sound and then timing how long it takes for the sound reflected off an object to return.  By knowing the speed of sound (about 343 m/s) the computer can calculate the distance to the object which reflected the sound.  The computer can make a graph of position versus time by making many consecutive distance measurements.  You can hear the motion detector 'click' every time a distance measurement is performed.

To use the motion detector effectively you must be aware of a few of its properties:

•
The motion detector will measure the distance to the closest object that reflects sound back to it.  If you are measuring the position of your body as you move away from the detector and you pass an object which also reflects sound back to the detector, then the detector will start measuring the position of the object you passed instead of your position.  Make sure there are no objects between you and the detector which might reflect sound back to it.  This includes things like your partner, books on tables, chairs, edges of cabinets, walls, etc.  

•
The motion detector beam gets larger as it travels further from the detector.  The beam is approximately the shape of a cone whose axis comes straight out from the front of the detector.  Right at the front of the detector the diameter of the cone is equal to the detector diameter (about 4 cm).  The cone half-angle is about 15 degrees;  thus its diameter 1 meter from the detector is about 50 cm, and it grows in direct proportion to the distance from the detector.  So at 2 meters away the cone is about 1 meter in diameter, and at 3 meters away it is about 1.5 meters in diameter.

•
The motion detector cannot read distances that are less than about 50 cm (1/2 m).  This is because it takes time for the detector to prepare itself to detect the reflected sound, and the sound returns too quickly for objects closer than about 50 cm.  The motion detector will generate a position measurement each time the computer asks it to, but if the nearest object is closer than about 50 cm, the data will be incorrect.

•  The accuracy of the motion detector depends on the strength of the reflected sound.  The reflected sound intensity decreases as the object whose position is being measured gets further away.  Depending on the size of the reflecting object and how well it reflects the sound, the maximum distance the detector can measure is about 4 meters.  Sound reflects better off of hard objects having a large smooth surface.  It reflects poorly off of hair or rumpled clothing.  Best results will be obtained if the motion detector is high enough to be aimed at the chest.  Holding a card or book against the body in front of the motion detector will generally help if you are wearing very bulky clothes, but the card (or book) must be held steady while walking, not randomly moved or waved. 

•  If there is no object in the path of the sound beam emitted by the motion detector, or if the sound reflected by an object in the beam is too weak, the motion detector will measure a very large distance.  A position measurement from the detector that is very large is a sure sign that insufficient sound is being reflected back to the motion detector.  

Investigation 1:  Distance (Position)-Time Graphs of Your Motion

The purpose of this investigation is to learn how to relate graphs of the distance as a function of time to the motions they represent.

You will need the following materials:

•
LoggerPro  Software

•
Experiment files for LoggerPro
•
Motion detector

•
Universal Laboratory Interface (ULI) 

•
Marks on floor showing distance from ranger (in meters)  

How does the distance-time graph look when you move slowly?  Quickly?  What happens when you move toward the motion detector?  Away?  After completing this investigation, you should be able to look at a distance-time graph and describe the motion of an object.  You should also be able to look at the motion of an object and sketch a graph representing that motion.

Comment:  "Distance" is short for "distance from the motion detector."  The motion detector is the origin from which distances are measured.


•
It detects the closest object directly in front of it 


(including your arms if you swing them as you walk).


•
It will not correctly measure anything closer than 1/2 

meter.  (When making your graphs don't go closer 
than 1/2 meter from the motion detector.)


•
As you walk (or jump, or run), the graph on the 

computer screen displays how far away from the 

detector you are.  

Activity 1-1:  Making Distance-Time Graphs

1.
This write-up assumes the LoggerPro program is up and running on your computer.  If it is not, ask you instructor for help.    

2.
Open the file M1in1a3 using the Open command in the File menu.  All the files you will need for this lab are in the 'Mechanics' folder that is located at the bottom of the following hierarchy of folders:  Experiments, _tst, Mechanics.  The graph axes should appear on the screen.  

3.
Each time you are ready to start graphing distance, click once on the Collect "button" at the right of the menu bar located above the graph window. 

4.
If you have a number line on the floor and you want the detector to produce readings that agree, stand at the 2-meter mark on the number line and have someone move the detector (if possible) until the reading is 2 meters.

5.  Make four distance-time graphs for different walking speeds and directions, and sketch your graphs on the axes below.

	Walking Away from Detector
	Walking Toward Detector

	a.
Walking away from the detector (origin) slowly and steadily.
	


	c.
Walking toward the detector (origin) slowly and steadily.  
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	b.
Walking away from the detector (origin) medium fast and steadily.  
	


	d.
Walking toward the detector (origin) medium fast and steadily.  
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Question 1-1:  Describe the difference between the graph you made by walking away slowly  and the one made by walking away more quickly.

Question 1-2:  Describe the difference between the graph made by walking toward  and the one made walking away from  the motion detector.

Comment:  It is common to refer to the distance of an object from some origin as the position of the object.  Since the motion detector is at the origin of the coordinate system, it is better to refer to the graphs you have made as position-time graphs.  From now on you will plot position-time graphs.

Prediction 1-1:  Predict the position-time graph produced when a person starts at the 1-meter mark, walks away from the detector slowly and steadily for 5 seconds, stops for 5 seconds, and then walks toward the detector quickly.  Draw your prediction on the left axes below using a dashed line. 

Compare predictions with the rest of your group.  See if you can all agree.  Draw your group's prediction on the left hand axes below using a solid line. (Do not erase your original prediction.) 

PREDICTION  



FINAL RESULT
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5.  Test your prediction.  Change the vertical axis of your graph by positioning the mouse pointer on the topmost number of the vertical axis scale and clicking the left mouse button.  The number will now be highlighted and enclosed in a small rectangular box.  Type in the new desired upper limit (in this case '2') and hit the enter key.  [Note:  use the 'backspace' key (not the 'delete' key) to erase incorrect entries.]  Change the upper limit of the time (horizontal) axis to '15' in the same manner.

Move in the way described above, and graph your motion.  When you are satisfied with your graph, draw your group's final result on the right axes above.

Question 1-3:  Is your prediction the same as the final result?  If not, describe how you would move to make a graph that looks like your prediction. 

Activity 1-2:  Matching a Position Graph

By now you should be pretty good at predicting the shape of a graph of your movements.  Can you do things the other way around by reading a position-time graph and figuring out how to move to reproduce it? In this activity you will match a position graph shown on the computer screen.

1.
Open the experiment file called M1in1a2.  A position graph like that shown below will appear on the screen. 
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Comment:  This graph (called Position Match) is stored in the computer as 'Run 1'.  New data from the motion detector are always stored as 'Latest', and can therefore be collected without erasing the Position Match graph.  


You may have noticed that data from the latest run are erased when you begin a new run, but if you wish to clear your screen without starting a new run you may do so by selecting Delete Run from the Data Menu, and selecting Latest to clear data from the latest run. 

2.
Move to match the Position Match graph on the computer screen.  You may try a number of times.  It helps to work in a team.  Get the times right.  Get the positions right.  Each person should take a turn.

Question 1-4:  What was the difference in the way you moved to produce the two differently sloped parts of the graph you just matched?

Activity 1-3:  Other Position-Time Graphs

It will be less confusing if you remove the Position Match graph from the screen before doing the exercises below.  To do this, select Delete Run from the Data menu and delete Run 1 and Latest.  

1.
Sketch your own position-time graph on the axes which follow with a dashed line.  Use straight lines, no curves.    Now see how well someone in your group can duplicate this graph on the screen by walking in front of the motion detector.
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2.
Draw the best attempt by a group member to match your position-time graph on the same axes.  Use a solid line.

Investigation 2:  Velocity-Time Graphs of Motion

You have already plotted your position as a function of time.  Another way to represent your motion during an interval of time is with a graph which describes how fast and in what direction you are moving.  This is a velocity-time graph.  Velocity is the rate of change of position with respect to time.  It is a quantity which takes into account your speed (how fast you are moving) and also the direction you are moving.  Thus, when you examine the motion of an object moving along a line, its velocity can be positive or negative meaning the velocity is in the positive or negative direction.

Graphs of velocity over time are more challenging to create and interpret than those for position.  A good way to learn to interpret them is to create and examine velocity-time graphs of your own body motions, as you will do in this investigation.  

Activity 2-1:  Making Velocity Graphs

1.
Set up to graph velocity.  Open the experiment M1in2a1 to set up the Velocity axis to read from -1 to 1 m/sec and the Time axis from 0 to 5 sec, as shown on the next page.

2.
Graph your velocity for different walking speeds and directions, and sketch your graphs on the axes.  (Just draw smooth patterns; leave out the “bumps” and “spikes” that are mostly due to unevenness in your steps.)

You may want to change the velocity scale so that the graph fills more of the screen and is clearer.  To do this click the mouse once with the cursor pointing to the maximum axis reading.  Type in the new value and hit enter.  Do the same for the minimum axis value.


Then sketch your graphs in the appropriate boxes below.  If you change the velocity scale just write in the appropriate number.

	Walking Away from Detector
	Walking Toward Detector

	a. walking away slowly and steadily
	c. walking toward slowly and steadily

	


	



	b. walking away medium fast and steadily
	d. walking toward medium fast and steadily

	


	




Question 2-1:  What is the most important difference between the graph made by slowly walking away from the detector and the one made by walking away more quickly?  (Ignore any slight "wiggles".  Concentrate on the overall shape.)

Question 2-2:  How are the velocity-time graphs different for motion away and motion toward the detector?

Prediction 2-1:  Predict a velocity graph for a more complicated motion and check your prediction.

Each person draw below, using a dashed line, your prediction of the velocity graph produced if you:

•
walk away from the detector slowly and steadily for about 5 seconds

•
stand still for about 5 seconds

•
walk toward the detector steadily about twice as fast as before

Compare your predictions and see if you can all agree.  Use a solid line to draw in your group prediction.








PREDICTION
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3.
Test your prediction.  (Be sure to adjust the time scale to 15 seconds. As mentioned before, this can be done by clicking the mouse once on the 5 to highlight it, typing in a 15 and then hitting the enter key. )  Repeat your motion until you think it matches the description.  


Draw the best graph on the axes below.  Be sure the 5-second stop shows clearly.







FINAL RESULT
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Comment:  Velocity implies both speed and direction.   How fast you move is your speed, the rate of change of position with respect to time.  As you have seen, for motion along a line (e.g., the positive x axis) the sign (+ or -) of the velocity indicates the direction.  If you move away from the detector (origin), your velocity is positive, and if you move toward the detector, your velocity is negative.

The faster you move away  from the origin, the larger positive number your velocity is.  The faster you move toward  the origin, the "larger" negative number your velocity is.  That is -4 m/s is twice as fast as -2 m/s, and both motions are toward the origin.

These two ideas of speed and direction can be combined and represented by vectors.  A velocity vector is represented by an arrow pointing in the direction of motion.  The length of the arrow is drawn proportional to the speed; the longer the arrow, the larger the speed.  If you are moving toward the right, your velocity vector can be represented by the arrow shown below.
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If you were moving twice as fast toward the right, the arrow representing your velocity vector would look like                                                     
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                   while moving twice as fast toward the left would be represented by the following arrow
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What is the relationship between a one-dimensional velocity vector and the sign of velocity?  This depends on the way you choose to set the positive x axis.  
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In both diagrams above, the top vectors represent velocity toward the right.  In diagram 1, the x axis has been drawn so that the positive x direction is toward the right, as it is usually drawn.  Thus the top arrow represents positive velocity.  However, in diagram 2, the positive x direction is toward the left.  Thus the top arrow represents negative velocity.  Likewise, in both diagrams the bottom arrows represent velocity toward the left.  In diagram 1 this is negative velocity, and in diagram 2 it is  positive velocity.

Question 2-3:  Sketch below velocity vectors representing the three parts of the motion described in Prediction 2-1.

Walking slowly away from the detector:

Standing still:

Walking rapidly toward the detector:

Activity 2-2   Matching a Velocity Graph

In this activity, you will try to move to match a velocity graph shown on the computer screen.  This is often much harder than matching a position graph as you did in the previous investigation.  Most people find it quite a challenge at first to move so as to match a velocity graph. 

1.
Using the Open command in the File menu, open the file M1in2a2.  The velocity graph shown below will appear on the screen.  (Note that the tick marks on the horizontal and vertical axes may be slightly different than are shown here.)
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2.
Move so as to imitate this graph.  You may try a number of times.  Work as a team and plan your movements.  Get the times right.  Get the velocities right.  Each person should take a turn.  


Draw in your group's best match on the axes above.

Question 2-4:  Describe how you moved to match each part of the graph.  

Question 2-5:  Is it possible for an object to move so that it produces an absolutely vertical line on a velocity time graph?  Explain.  

Question 2-6:  Did you run into the motion detector on your return trip?  If so, why did this happen?  How did you solve the problem?  Does a velocity graph tell you where to start?  Explain.

Investigation 3:  Relating Position and Velocity Graphs

You have looked at position and velocity-time graphs separately.  Since position-time and velocity-time graphs are different ways to represent the same motion, it ought to be possible to figure out the velocity at which someone is moving by examining her/his position-time graph.  Conversely, you ought to be able to figure out how far someone has traveled (change in position) from a velocity-time graph.

Activity 3-1  Predicting Velocity Graphs from Position Graphs

1.
Set up to graph Position and Velocity.  Open the experiment M1in3 to set up the top graph to display Distance (or Position) from 0 to 4 m for a time of 5 sec, and the bottom graph to display Velocity from -1 to 1 m/sec for 5 sec.   

Prediction 3-1:  Predict a velocity graph from a position graph.  Carefully study the position-time graph shown below and predict the velocity-time graph that would result from the motion.  Using a dashed line, sketch your prediction of the corresponding velocity-time graph on the velocity axes.
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2.
Test your prediction.  After each person has sketched a prediction, Collect data, and do your group's best to make a position graph like the one shown.  Walk as smoothly as possible.


When you have made a good duplicate of the position graph, sketch your actual graph over the existing position-time graph.


Use a solid line to draw the actual velocity graph on the same graph with your prediction.  (Do not erase your prediction).

Question 3-1:  How would the position graph be different if you moved faster?  Slower?  

Question 3-2:  How would the velocity graph be different if you moved faster?  Slower? 

Activity 3-3  Predicting Position Graphs from Velocity Graphs

Prediction 3-2:  Carefully study the velocity graph shown below.  Using a dashed line, sketch your prediction of the corresponding position graph on the bottom set of axes.  (Assume that you started at the 1-meter mark.)
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1.
Test your prediction.  Reset the Time axis to 0 to 10 sec (for both graphs) and delete any previous data using the Delete Run command in the Data menu.

2.
After each person has sketched a prediction, do your group's best to duplicate the top (velocity-time) graph by walking.  Be sure to graph velocity first.  


When you have made a good duplicate of the velocity-time graph, draw your actual result over the existing velocity-time graph.

3.
Use a solid line to draw the actual position-time graph on the same axes with your prediction. (Do not erase your prediction.)

Question 3-5:  How can you tell from a velocity-time graph that the moving object has changed direction?  

Question 3-6:  What is the velocity at the moment the direction changes?  

Question 3-7:  Is it possible to actually move your body (or an object) to make vertical lines on a position-time graph?  Why or why not?  What would the velocity be for a vertical section of a position-time graph?  

Question 3-8:  How can you tell from a position-time graph that your motion is steady (motion at a constant velocity)?  

Question 3-9:  How can you tell from a velocity-time graph that your motion is steady (constant velocity)?
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